
Neutron Training Course
Reflectivity Practical Worksheet

1 Adsorption Isotherm of SDS

Sodium dodecyl sulphate (SDS or Na-DS) (C12H25SO4Na), is an anionic surfactant
that is used in household products such as toothpastes, shampoos, shaving foams,
some disolveable asprins, and bubble baths for its thickening effect and its ability
to create a lather. The molecule has a tail of 12 carbon atoms, attached to a sulfate
group, giving the molecule the amphiphilic properties required of a detergent. Its
structure is shown below:

Figure 1: Structure of SDS.

The free energy of a surface covered with hydrophobic groups is much lower
than that of water. There is therefore a strong tendency of amphiphilic molecules
to adsorb at the surface of water in order to lower its free energy. The excess
of surfactant adsorbed at the interface can be described by the Gibbs adsorption
isotherm

Γs = − 1

2RT

(
∂γ

∂ ln C

)

T,P

, (1)

where C is the concentration in the bulk solution, R is the gas constant, T the tem-
perature and γ the surface tension. Γs is the surface concentration, which represents
the excess of solute per unit area of the surface over what would be present if the
bulk concentration prevailed all the way to the surface.

Measuring the Gibbs adsorption isotherm can be quite difficult, and requires
accurate measurement of the surface tension. An alternative method is to indepen-
dently measure the amount of adsorbed surfactant at the interface to arrive at the
surface excess. This can be done using neutron reflectivity. The aim of this practical
is to determine the Gibbs adsorption isotherm of SDS in water using neutron reflec-
tion. To do this, we will use neutrons to measure the amount of SDS adsorbed to
the surface of aqueous solutions as a function of concentration. We will use selective
deuteration to highlight the surface layer of surfactant.

As you will recall from your lectures, the scattering length density of hydro-
gen containing materials can be varied by isotopic substitution of hydrogen with
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deuterium. By increasing the amount of deuteration in a sample, it is possible to
’tune’ the SLD of a given material so that this either dominates or is removed from
the total scattering (this is called ’contrast matching’). Since we are interested in
measuring the amount of surfactant adsorbed on the surface, we need to control the
deuteration so that the surface layer is highlighted and the bulk subphase is hidden.
This is shown schematically in Figure 2. In the left image, h-SDS has a small
negative SLD, the SLD of air is zero, whilst the SLD of the bulk water phase has a
small negative value. In this case, it is difficult to resolve the scattering of the SDS
layer. However, by adding a small amount of D2O to the subphase, it is possible to
adjust the SLD of the subphase so that this is matched to the air at zero. Then,
by using a deuterated surfactant, the resulting interface is dominated by the SDS,
making the adsorbed layer easy to resolve.

Figure 2: Contrast matching of SDS. (a) For h-SDS on H2O, the surface layer is not clearly
resolved from the bulk. By matching the bulk to air (Air Contrast Matched Water, ACMW), and
deuterating the SDS, it is possible to highlight the adsorbed layer, making the surface excess easier
to measure.

For this case of a deuterated surfactant in null-reflecting water, the reflectivity
arises solely from the adsorbed surfactant layer at the air water interface, and is
related directly to the surface excess G and area per molecule A.

2 Methods

2.1 Sample Preparation

• Make up a mixture of D2O and H2O that has an overall scattering length
density (SLD) of zero. The SLD of water is -0.55e-6 Å-2, that of D2O is 6.35e-
6 Å-2, and the SLD of D2O/H2O mixtures varies linearly with composition.
At 20◦C, 100ml of ACMW is made up from 8.784g of D2O and 91.884g of
H2O. You will require about 200 mL of ACMW for this experiment.

• Make up 4 solutions of d-SDS in ACMW, at concentrations of 0.0001 M, 0.0005
M, 0.001M and 0.007M (The CMC is about 0.008). You will need 50 mL of
each.
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• Clean the 5 PTFE troughs used for the experiment. Do this by wiping the
troughs well with Acetone (in the fume hood) and then thoroughly rinsing the
troughs with ultrapure water. Avoid getting any fingerprints on the troughs
(wear gloves!). Store the troughs wrapped in tissue paper to keep them clean.

2.2 Neutron reflection measurements

• Load the cleaned PTFE troughs into the 5 position holder on the beamline.

• Pour 50 mL of your SDS solutions into 4 of the troughs, making sure that they
are completely filled. Load the final trough with 50 mL D2O.

• Set the vertical slit openings to 4mm, 3mm, 3mm and 4mm for slits 1,2,3
and 4 respectively. Set the detector angle to 1.5◦. Remove the transmission
monitor and the frame overlap mirror from the beam so that the alignment
laser illuminates the sample. Adjust the height of the sample so that the laser
reflects of the surface of the solutions and hits the detector without touching
the slits. Do this for each of the 5 troughs (by translating the sample) and
make a note of the height and position in each case. Put the transmission
monitor and frame overlap mirror back into the beam, and close the beamline.

• Write a command file to measure the reflectivity from each trough separately.
An example command file is provided. The command file moves the sample
translation to each trough position, adjusts the height for each trough, begins
the count, waits for 180 µamps and then ends the run. Make a note of the run
numbers in each case.

2.3 Data Reduction

’Data reduction’ refers to the process of converting the raw data collected at the
detector into absolute reflectivity. There are several stages in this process. The
incident intensity (as a function of wavelength) is measured by the monitor, whist
the reflected intensity is measured at the detector. The reflected intensity is divided
by the incident intensity to give reflectivity as a function of wavelength. Then, the
units are converted from wavelength into qz, where

qz =
4π

λ
sin (θ) (2)

(remember that these measurements were done at a single incident angle of θ = 1.5◦,
and a range of wavelengths). During the reduction process, the data is corrected by
the software to account for non-ideal responses of the detector and monitor.

For an ideal instrument, the steps above would lead to an absolute reflectivity.
However, in the real world, the instruments are not 100% efficient, and so the actual
reflectivity measured will be less than the ideal case. This needs to be corrected using
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a scaling factor to account for the less than perfect efficiency. At ISIS, we obtain
the scale factor from a standard sample, which for the air-water interface case is
the clean D2O surface that we measured in the practical. An alternative method
is to measure the direct, transmitted beam (while taking care not to saturate the
detector by selecting smaller slits) and calculating the true reflectivity from the ratio
of reflected and transmitted beam.

3 OpenGenie

Fortunately, software is provided on the ISIS reflectometers for data reduction. The
package we use is called OpenGenie and is installed on the computers in the data
analysis room. There will be several stages in the data reduction process:

• Reduce the data from the D2O standard sample.

• Fit this data to obtain the scale factor.

• Reduce the data for each SDS run using this scale factor.

• Export the reduced data as ASCII files ready for analysis.

3.1 Reducing the D2O data

Start OpenGenie by clicking on the icon on the desktop. Select ’s’ to ’start with
(s)urf data setup’. The main OpenGenie window will open

Figure 3: OpenGenie session window.

To use OpenGenie, we type commands at the ’À’ cursor.

4



The routine used for reducing simple reflection measurements at a single incident
angle is called ’quick’. Type this at the command prompt.You will be prompted for
a run number, type the run number of the D2O sample that you ran in the practical.

You will then be prompted for an incident angle. Enter 1.5 degrees.

OpenGenie will then process that data, and put the reduced data into a workspace.
We require the workspace which has been converted to qz and rebinned. This is the
’wrq’ output from ’quick’. To visualise this workspace, type ”d/m wrq”. The re-
binned reflectivity from the D2O run will then be plotted as a function of qz. To
obtain a scale factor from this run, we need to fit the data. There is a simple routine
in OpenGenie which can be used for this, which is called ’mulf’. To run it type ’mulf
wrq’ at the command prompt. You will then be prompted with a series of questions
about the fit required. The values for these should be entered as shown below

Figure 4: OpenGenie session window with ’mulf’ fitting programme parameters.

Mulf should then run, and result in a fit to the D2O data. You should make a
note of the output of the fitted parameters for the background, scale factor and the
air/film roughness.

3.2 Fitting your data with MULF or RasCAL

The isotherm data can be fitted as a single layer of thickness τ and scattering length
density Nb using MULF. Alternatively, or for more complicated fitting models the
RasCAL software is available (see Appendix).
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3.3 Calculating the isotherm

To calculate the adsorption isotherm, it is necessary to calculate the surface excess
of SDS at the interface at each bulk concentration. To do this, you require the values
for the layer thickness and SLD from the fits done with MULF or RasCAL.

For an assumed uniform layer at the air/water interface, the area per molecule
(APM) of surfactant can be calculated from

APM =
Σb

ρτ
(3)

where ρ is the scattering length density, and τ is the layer thickness. Σb refers
to the total scattering length for d-SDS.

The area per molecule (in Å2) is then related to the surface excess as

APM =
1020

NsΓs

(4)

To calculate the isotherm...

• Calculate Σb for d-SDS. Its formula is C12D25SO4, and the scattering lengths
for each element are

nH = -3.7406 fm (=1e-15m, =1e-5Å)
nD = 6.671 fm
nC = 6.646 fm (includes natural abundance of 12C and 13C)
nS = 2.847 fm (nat. ab.)
nO = 5.803 fm
so Σb will be given by (12*nC) + (25*nD) + (1*nS) + (4*nO).

• Calculate the limiting APM for each SDS concentration.

• For each concentration, calculate the surface excess.

• Plot Γs against the bulk SDS concentration to obtain the adsorption isotherm.
(Think about the units!)

Appendix
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1. What is Rascal? 
Rascal is a program for analysing non-polarised neutron reflectivity data at multiple contrasts.  There are 

two versions; a Matlab version or a standalone application. The latter has some features absent 

compared to the full Matlab version.  

2. Installation. 
 

3. Basics 
Rascal is designed to fit multiple contrast neutron reflection data, primarily using Abeles layer models 

(although it is possible to define user functions in the Matlab edition). The basic principle of RasCAL is 

that simultaneous fitting of multiple contrasts requires some parameters to be shared between 

contrasts, whilst some will be unique to a given contrast.  In RasCAL, the parameters of the problem are 

defined separately, and then grouped together into a ‘contrast’ at the end. In this way, it makes it easy 

to share parameters between datasets, and simplifies the analysis of multiple contrast data. 

Consider two datasets from a lipid monolayer at the air-water interface. The data is of the same 

material, except that in one case the chains are hydrogenated, whereas in the other, the lipid has 

deuterated chains. Each dataset will be modelled using two layers; one for the tails and one for the 

heads. 

In RasCAL, Each layer is described by four parameters; a thickness, a Scattering Length Density, a 

roughness and (optionally) a hydration parameter. Consider the lipid tails of the two materials. 

Assuming the structure of the monolayer is not drastically changed by the deuteration, the tails should 

have the same thickness’ and roughness in the two samples. However, each layer will require its own 

value for the scattering length density. Therefore, we must define four parameters, and group these into 

two layers, and then distribute these layers between the two contrasts, as shown in figure 1.  Then, by 

minimising (fitting) the parameters, the fit will find the best values of the four parameters (including the 

shared parameters) that optimally describe both datasets simultaneously. 

In addition to the parameters that make up the layers, each contrast requires further information, such 

as the scattering length density of the bulk phases or the instrument resolution. Within RasCAL, these 

are also defined separately and then grouped together into contrasts and shared as required. In this way 

it is possible to quickly set up simultaneous analysis of multiple contrasts of neutron reflection data. 

4. Getting Started – A Quick Example. 
In this example, we will set up a simultaneous fit of some neutron reflectivity data using a two-layer 

model. The data to be analysed is reflectivity from a monolayer of lipid at the air-water interface. The 

lipid consists of two groups, a headgroup and a tail region, each of which will be described by one of the 
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layers. We will set up a simultaneous fit of 4 contrasts; either deuterated head or deuterated tail, on 

D2O or Air Contrast Matched Water, as summarised in the table below… 

Contrast 1 Deuterated Tails Hydrogenated Heads D2O 

Contrast 2 Deuterated Tails Deuterated Heads ACMW 

Contrast 3 Hydrogenated Tails Deuterated Heads D2O 

Contrast 4 Hydrogenated Tails Deuterated Heads ACMW 

 

(a) Setting up the model. 

First, start rascal, either by double clicking on the RasCAL icon for the standalone version, or typing 

‘rascal’ at the Matlab command prompt. The RasCAL session will open with the default project loaded, 

which is a simulation of the reflectivity from a D2O subphase.  

 

This model has no layers, and only one parameter – the substrate roughness. To set up out four 

contrasts, first we will create a new project directory. We will then define the parameters and layers, 

and group these into our four contrasts. We will then load in the data files and carry out a simultaneous 

fit of the four contrasts using our layer model. 

Firstly, create a new project directory, by clicking on the ‘File’ menu and selecting ‘New’. A dialog box 

will open. Enter the name of the new project directory in an appropriate location, and click ‘OK’.. 
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RasCAL will create a new project directory, and open the newly created project. 

The next task is to add the parameters necessary to describe the two layer model. Changes to a project 

can only be made from the ‘Edit’ dialog. To open this dialog, select ‘Edit project’ from the ‘Edit’ menu.  

 

The dialog allows the different components of the project to be edited. We will first create the 

parameters required to describe our 2 layer model. Then we will create the ‘experimental parameters’ 

(i.e. bulk phase SLD’s, scale factors, resolutions etc) that will be needed to describe the 4 contrasts. Then 

we will define the 4 contrasts themselves. 

Start by selecting the ‘Parameters’ tab on the Edit window. There will be one parameter listed, the 

substrate roughness, which is always the first parameter in any Rascal layer model. To add further 

parameters, click the ‘Add Parameters’ button. To remove parameters, first highlight them in the table 

and click the ‘Remove Parameters’ button.   
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We wish to construct a two layer model, in which the layers can be either deuterated or hydrogenated. 

First, we will create a layer for a deuterated tails. This will require three parameters; the thickness, the 

SLD, and roughness. To do this, click on ‘Add Parameters’ three times, and edit the remaining boxes until 

their values are sensible. Give each parameter a name and a value, and also define upper and lower 

value bounds for the parameters. Each parameter name must be different, and cannot be modified 

outside the ‘edit’ dialog. The numerical values however can be changed outside the edit dialog. You 

should end up with something resembling the following.. 

 

 

We will now group these parameters together into a layer representing the deuterated tails. Click on the 

‘Layers’ tab, and then click ‘Add Layer’. A row will appear in the table representing the new layer. Each 

layer requires a parameter for the thickness, SLD, roughness and an optional degree of hydration, as 

well as a name. Click on the first cell of the layer and give it a sensible name. Then, clicking on each of 

the remaining cells of the new layer brings up a drop down menu of the parameters that we have just 

defined. Select the appropriate parameter for each cell (we will assume that the tails are not hydrated in 

our model, and so it will be left blank for 0% hydration). 
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We now have a layer which can be used in an Abeles model to describe reflectivity data. To see how this 

is done, click on the ‘Contrast 1’ tab, and a window will appear showing all the parameters which 

describe this contrast. As well as layers, each contrast is associated with a number of ‘experimental 

parameters’, which control the background, scale factor, SLD’s of the bulk phases,  instrument 

resolution and Qz shift (caused by alignment errors). These are set under the ‘Experimental Params’ tab, 

which we will do later. 

In our simultaneous fit, we will be analysing data from layers containing both deuterated and 

hydrogenated tails, and also deuterated and hydrogenated heads. Repeat the steps above to complete 

the model (so, we will require parameters for the heads thickness and roughness, the SLD’s and also the 

hydration, making 10 parameters. These will then be grouped together into 4 layers). Create the new 

parameters, giving them meaningful names and values, and then group these together to form the four 

layers, as shown below.. 

Hint: When you have defined your parameters and layers, these can be saved, and then imported into other 

projects, so that each fit type need only be defined once. Use the ‘Export Model’ button on the General tab to 

do this. 
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Now that we have defined our parameters and layers, we now wish to define the other parameters 

required to model the data, namely the backgrounds, the scale factors, the SLD’s of the bulk phases and 

the instrument resolution. As with the parameters, any number of these can be defined, and then 

shared between contrasts. In this example, we have two different subphases (D2O or Air Contrast 

Matched Water), and we will assume that the background levels are controlled mainly by the hydrogen 

content of the subphase (i.e. two background parameters will be required, and assigned to the contrasts 

as required).  Additionally, we will assume that the same scale factors and instrument resolution applies 

to each contrast. 

These parameters are set in the ‘Experimental Partameters’ tab. Select this tab, scroll down (using the 

scrollbar on the right) to locate the ‘SLD bulk 2 (beam out)’ table. Click the ‘Add’ button above it. A new 

row will appear in the table. Call this ‘ACMW’, set its value to zero, and the bounds to reasonable values. 

Do the same to add a second ‘background’ parameter. Only one each of the other parameters is 

required. You should now end up with something that looks like the following… 
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(b) Defining the four contrasts. 

Now that all the parameters have been defined, we need to group them together into the contrasts 

from the table at the start of this section.  

We require four contrasts in total. So, to create the other three contrasts, use the ‘Add Contrasts’ 

button on the ‘General’ tab. Click on the ‘Contrast 1’ tab to begin defining this. Begin by giving the 

contrast a meaningful name, in this case ‘D-tail / H-head / D2O’. 

Each contrast panel consist of drop-down menus for the experimental parameters, and a ‘layers table’, 

showing which of our defined layers are used to make up the Abeles model for this contrast. For each of 

the contrasts in this example, we wish to include two layers (tail and head). To add layers, we first 

highlight the position in the layers table where we want the layers to go, and then add them 

(unsurprisingly!) with the add layers button. Highlight the last ‘layer’ (actually the ‘bulk out’ layer in the 

table), and click on ‘Add Layer’ twice. Two layers should appear. Now, to build up the model, we wish to 

include the relevant layers that we defined in the last section in the correct order. Clicking on one of the 

blank layers, you will see that a drop-down menu appears, containing the names of our layers. Select 

‘deuterated tails’ and ‘hydrogenated heads’ respectively, making sure that the heads are next to the 
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‘bulk out’ (i.e. that the lipids are the right way up!). Then, we need to make sure that the correct 

backgrounds are associated with this contrast. In this case, we wish to select ‘Background D2O’.  You 

should end up with something that looks like the following.. 

 

 

Now, set up the remaining 3 contrast panels for the contrasts as shown in the table at the start of this 

example. 

The final thing that needs to be done is to load in some data. For each contrast, data can be loaded in as 

an ASCII file, or as ISIS raw data (by sending commands to an OpenGenie session). Alternatively, the 

contrasts can be run as simulations (i.e. no data). For this example, we will load in the ASCII files 

provided in the ..Rascal_functions\Docs\demo datafiles\ directory.   

On the first contrast panel, select the “ASCII File” option from the drop-down “Type” menu. A text box 

appears showing the path of the datafile. To locate the correct file, use the ‘Browse’ button, navigate to 

the “..Rascal_functions\Docs\demo datafiles\ “  directory, and select  the “dTails_hHeads_D2O.dat” file. 

Repeat this for the other three contrasts (making sure to select the correct file for each one). All being 

well, we are now ready to begin analysing the data.  Click on the ‘OK’ button at the bottom right of the 

edit GUI, and the editing GUI should now disappear, leaving the original RasCAL windows, with the data 

loaded in and set up to be analysed with our two-layer model.  

(c) Analysing the Data.  

If the model has been correctly set up, you should end up with something that looks like the following (if 

not, RasCAL will produce an error, and you should check your project carefully)… 



RasCAL Quick Start Guide. 

 

 

The main RasCAL screen has four windows, The Plotting Window, the Main Window, the Information 

Window and the Controls Window.  Before analysing the data, let’s look at these in turn. 

Plotting Window 

The plotting Window displays the 

fits and SLD’s of the current 

project. In addition to the two 

plots, there are three controls. The 

slider on the left of the Reflectivity 

plot allows the individual contrasts 

to be shifted vertically relative to 

each other. So, they can be 

overlaid to compare plots, or 

separated to examine the 

individual fits.  The other two 

buttons allow error bars to be 

shown or hidden, or to turn on / 

off log scale plotting for the Qz 

axis.  
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Additional functions can be accessed by right clicking on the individual plots.  These allow you to rescale 

the graphs, export them to disk (as *.PNG files), or print. Note that you can also zoom / un-zoom by 

dragging the mouse on the charts without having to access the menu. 

The Main Window. 

 This window gives the details about 

the current fit, including all the 

current values of the parameters.  

The first three tabs look similar to 

those in the ‘Edit’ menu, and give all 

the details of the current model. For 

the Parameters and Experimental 

Parameters, note that there is an 

extra column of ‘tick boxes’ in each 

table. These boxes are used to select 

which parameters are fit (or 

otherwise analysed). Only boxes 

that are ticked are included in the 

fits, manual ‘sliders’, or error 

analysis tasks (see later). In each of 

the tables, it is also possible to edit 

the ranges or parameter values by 

double clocking on the relevant 

cells.   

Each contrast also has a separate tab, showing the details that you set up in the edit menu, along with 

some additional controls. These allow you to repeat the layers in the model, or control the range of the 

data or simulation. To repeat the stack of layers, click on the ‘Repeat Layers’ check box, and then type in 

the number of repeats. The data and simulation ranges can also be altered from the text boxes at the 

bottom. The simulation ranges can be extended beyond the data, so see what the reflectivity will look 

like beyond the current data range, but note that the simulation cannot be shorter than the data range. 

Also, note that only the currently displayed data range contributes to the value of chi-squared, and so 

this range can be used to select which portion of the data to fit. 

Controls Window 

The controls the fit on the current project.  In 

the top two text boxes, it displays the fitting 

algorithm being used (either Simplex or the 

Genetic algorithm), and the current value of chi 

squared. The third box allows the maximum 

number of iterations to be set. If there is no 

maximum value required (i.e. fit until converged), put ‘inf’ in this box instead of a number. The two 
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buttons will start and stop the fit as required. Note that the status of the stop button is only checked at 

intervals during the fit, and so there may be a delay after it is pressed before the fit actually stops. 

‘Manual’ Data analysis using ‘sliders’. 

It is often good practice to try to manually find a reasonable fit, before running the fitting algorithms. To 

make this easier, RasCAL allows the 

parameters to be changed 

manually using ‘sliders’. To open 

the sliders window, go to the 

‘Tools’ menu, and select ‘Show 

Sliders’. A window opens with a 

slider for each of the checked 

parameters in the Main Window 

(note that the range of each slider 

is governed by the bounds set for 

the parameter). You can adjust the 

value of each of the parameters my 

moving the sliders, and the plots of 

the fits will update in real time. 

Once you are happy with the fit, 

click ‘OK’, and the values in the 

tables will be updated with the 

values of the sliders. Clicking 

‘Cancel’ clears the window, and 

returns to the previous fit. 

Running a Fit. 

To run a fit, you must first choose a fitting algorithm. In RasCAL, data can be fit using either a Simplex 

Algorithm, or a modified Genetic Algorithm. The algorithm used is chosen from the ‘Tools’ menu. The 

Simplex offers faster convergence when the starting point is closer to the true minimum. The GA  

provides a more robust search of the parameter space, and so has a better chance of finding the true 

minimum of the problem, but requires many more function evaluations than the Simplex (and is 

therefore much slower). The maximum iterations can be set from the Controls Window. Other 

properties of the fit (such as convergence targets etc) can be set from the ‘Preferences’ option from the 

Tools menu.  

(d) Analysing the Fit Results. 
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